Introduction to Banner

Your Obligation as a Banner Student System User:

Users have the obligation to be aware of federal regulations (FERPA-Family Educational Rights and Privacy Act), state codes, and university policy applicable to the inspection and release of student information under the jurisdiction of their office. Any questions on the inspection and release of student information should be addressed to the Registrar’s Office. Student information (Data) is protected (privileged) and can (shall) only be inspected pursuant to the provisions of legitimate business of The University of Texas at El Paso.
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter/Form</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Educational Rights and Privacy Act (FERPA)</td>
<td>iii</td>
</tr>
<tr>
<td>General Policy</td>
<td>iv</td>
</tr>
<tr>
<td>Directory Information</td>
<td>iv</td>
</tr>
<tr>
<td>Access to File</td>
<td>v</td>
</tr>
<tr>
<td>Challenge to Record</td>
<td>vi</td>
</tr>
<tr>
<td>Copies</td>
<td>vi</td>
</tr>
<tr>
<td>Complaints</td>
<td>vi</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>How to Log On</td>
<td>2</td>
</tr>
<tr>
<td>Main Menu</td>
<td>3</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>4</td>
</tr>
<tr>
<td>File Menu</td>
<td>4</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>5</td>
</tr>
<tr>
<td>Options Menu</td>
<td>5</td>
</tr>
<tr>
<td>Query Menu</td>
<td>6</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>6</td>
</tr>
<tr>
<td>Help Menu</td>
<td>6</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>7</td>
</tr>
<tr>
<td>Title Bar</td>
<td>8</td>
</tr>
<tr>
<td>Go To Field</td>
<td>8</td>
</tr>
<tr>
<td>Hierarchical Menu</td>
<td>8</td>
</tr>
<tr>
<td>Products Field</td>
<td>8</td>
</tr>
<tr>
<td>Menu Link</td>
<td>8</td>
</tr>
<tr>
<td>Site Map Link</td>
<td>9</td>
</tr>
<tr>
<td>Help Center Link</td>
<td>9</td>
</tr>
<tr>
<td>My Links Area</td>
<td>9</td>
</tr>
<tr>
<td>My Institution</td>
<td>10</td>
</tr>
<tr>
<td>Broadcast Messages</td>
<td>10</td>
</tr>
<tr>
<td>Forms</td>
<td>11</td>
</tr>
<tr>
<td>7-Character ID Code</td>
<td>11</td>
</tr>
<tr>
<td>Parts of a form</td>
<td>12</td>
</tr>
<tr>
<td>Title Bar</td>
<td>12</td>
</tr>
<tr>
<td>Fields</td>
<td>12</td>
</tr>
<tr>
<td>Key Block</td>
<td>12</td>
</tr>
<tr>
<td>Information block</td>
<td>13</td>
</tr>
<tr>
<td>Tabs</td>
<td>13</td>
</tr>
<tr>
<td>Pull-down Lists</td>
<td>13</td>
</tr>
<tr>
<td>Radio Buttons</td>
<td>13</td>
</tr>
<tr>
<td>Checkboxes</td>
<td>14</td>
</tr>
<tr>
<td>Calendar Icons</td>
<td>14</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter/Form</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Person Forms</td>
<td>15</td>
</tr>
<tr>
<td>General Person Identification Form (SPAIDEN)</td>
<td>15</td>
</tr>
<tr>
<td>Hold Information (SOAHO LD)</td>
<td>20</td>
</tr>
<tr>
<td>General Student Forms</td>
<td>21</td>
</tr>
<tr>
<td>General Student (SGASTDN)</td>
<td>21</td>
</tr>
<tr>
<td>Registration Forms</td>
<td>23</td>
</tr>
<tr>
<td>Registration Query</td>
<td>23</td>
</tr>
<tr>
<td>Student Registration Permit-Override Form (SFASRPO)</td>
<td>24</td>
</tr>
<tr>
<td>Academic History Forms</td>
<td>25</td>
</tr>
<tr>
<td>Degree and Other Formal Awards Form (SHADEGR)</td>
<td>25</td>
</tr>
<tr>
<td>Academic History by Term (SHATERM)</td>
<td>26</td>
</tr>
<tr>
<td>Academic History by Subject (SHASUBJ)</td>
<td>28</td>
</tr>
<tr>
<td>Academic History by Course (SHACRSE)</td>
<td>29</td>
</tr>
<tr>
<td>Other Forms</td>
<td>30</td>
</tr>
<tr>
<td>Test Scores and Grades (SOATEST)</td>
<td>30</td>
</tr>
<tr>
<td>Add/Change Personal Links</td>
<td>31</td>
</tr>
<tr>
<td>Changing you Password in Banner</td>
<td>32</td>
</tr>
</tbody>
</table>
Family Educational Rights and Privacy Act (FERPA)

Student Affairs

The Family Educational Rights and Privacy Act (FERPA), 20 U.S.C. §1232g, and the Texas Public Information Act, Texas Government Code §552.001 et seq., are respectively a federal and state law that provide for the review and disclosure of student educational records. In accordance with these laws the University has adopted the following policy. Individuals are informed of their rights under these laws through this policy which is included in the University Handbook of Operating Procedures and Catalog. This catalog may be found on-line at:  http://www.it.utep.edu/hoop/

8.1 General Policy
The University will not permit access to or the release of personally identifiable information contained in student education records without the written consent of the student to any party, except as follows:

A. to appropriate university officials who require access to educational records in order to perform their legitimate educational duties;
B. to officials of other schools in which the student seeks or intends to enroll, upon request of these officials, and upon the condition that the student be notified and receive a copy of the record if desired;
C. to federal, state, or local officials or agencies authorized by law;
D. in connection with a student's application for, or receipt of, financial aid;
E. to accrediting organizations or organizations conducting educational studies, provided that these organizations do not release personally identifiable data and destroy such data when it is no longer needed for the purpose it was obtained;
F. to the parents of a dependent student as defined in section 152 of the Internal Revenue Code of 1954, provided a reasonable effort is made to notify the student in advance;
G. in compliance with a judicial order or subpoena, provided a reasonable effort is made to notify the student in advance unless such subpoena specifically directs UTEP not to disclose the existence of a subpoena;
H. in an emergency situation if the information is necessary to protect the health or safety of the students of other persons; or
I. to an alleged victim of any crime of violence, the results of the alleged perpetrator's disciplinary proceeding may be released.

The University will release information in student education records to appropriate University officials as indicated in “A” above when such records are needed by administrators, faculty, staff in furtherance of the educational or business purposes of the student or University. A record of requests for disclosure and such disclosure of personally identifiable information from student education records shall be maintained by Registrar's Office for each student and will also be made available for inspection pursuant to this policy. If the UTEP discovers that a third party who has received student records from UTEP has released or failed to destroy such records in violation of this policy, it will prohibit access to educational records for five (5) years. Respective records no longer subject to audit or presently under request for access may be purged according to regular schedules.

8.2 Directory Information
At its discretion, the University may release Directory Information which shall include:

A. name, address, telephone number
B. date and place of birth
C. major field of study
D. participation in officially recognized activities and sports
Family Educational Rights and Privacy Act (FERPA)

E. dates of attendance
F. most recent previous educational institution attended
G. classification
H. degrees and awards received
I. date of graduation
J. physical factors (height and weight) of athletes
K. class schedules

Students may have any or all Directory Information withheld by notifying the Office of the Registrar in writing each semester during the first 12 days of class of a fall or spring semester, the first 4 class days of a summer semester, or the first 3 days of any quarter. Request for non-disclosure will be honored by UTEP for only the current enrollment period; therefore, a request to withhold Directory Information must be filed each semester or term in the Office of the Registrar.

8.3 Access to File

Upon written request, UTEP shall provide a student with access to his or her education records. The Vice President for Finance and Administration has been designated by the President to coordinate the inspection and review procedure for student education records, which include admissions files, academic files, and financial files. Students wishing to review their education records must make written requests to the Vice President for Finance and Administration listing the items or items of interest. Education records covered by the Act will be made available within 45 days of the request.

A list of education records and those officials responsible for the records shall be maintained at the Vice President's Office. This list includes:

8.3.1 Academic Records
Registrar's Office (Admissions/Registrar): Registrar College, Division, Department and Faculty Offices

8.3.2 Student Services Records
Counseling Office: Director of Counseling
Student Activities Office: Director of Student Activities
Student Services: Dean of Students

8.3.3 Financial Records
Business Office: Vice President for Finance and Administration
Financial Aid Office: Director of Financial Aid

Educational records do not include:
1. financial records of the student's parents or guardian;
2. confidential letters of recommendation which were placed in the educational records of a student prior to January 1, 1975;
3. records of instructional, administrative, and educational personnel which are kept in the sole possession of the maker and are not accessible or revealed to any other individual except a temporary substitute for the maker;
4. records of law enforcement units;
5. employment records related exclusively to an individual's employment capacity;
6. medical and psychological records;
7. thesis or research papers; or
8. records that only contain information about an individual after the individual is no longer a student at the institution.
8.4 Challenge to Record
A. Students may challenge the accuracy of their educational records. Students who believe that their education records contain information that is inaccurate or misleading, or is otherwise in violation of their privacy may discuss their problems informally with Vice President for Student Affairs. If agreement is reached with respect to the student's request, the appropriate records will be amended. If not, the student will be notified within a reasonable period of time that the records will not be amended, and they will be informed by the Vice President for Student Affairs of their right to a formal hearing.
B. Student requests for a formal hearing must be made in writing to the Vice President for Student Affairs, who, within a reasonable period of time after reviewing such requests, will inform students of the date, place and the time of the hearing. Students may present evidence relevant to the issues raised and may be assisted or represented at the hearings by one or more persons of their choice, including attorneys, at the student's expense. The Hearing Officer that will adjudicate such challenges will be appointed by Vice President for Finance and Administration for non-academic matters, and by the Vice President for Academic Affairs in academic matters.
C. Decisions of the Hearing Officer will be final, will be based solely on the evidence presented at the hearing, will consist of the written statements summarizing the evidence and stating the reasons for the decisions, and will be delivered to all parties concerned.
D. The education records will be corrected or amended in accordance with the decision of the Hearing Officer, if the decision is in favor of the student. If the decision is unsatisfactory to the student, the student may place with the education records statements commenting on the information in the records or statements setting forth any reasons for disagreeing with the decision of the Hearing Officer, or both.
E. The statements will be placed in the education records, maintained as part of the student's records, and released whenever the records in question are disclosed.
F. Students who believe that the adjudications of their challenges were unfair or not in keeping with the provisions of the Act may request in writing, assistance from the President of the institution.

8.5 Copies
Students may have copies of their educational records and this policy. These copies will be made at the student's expense at rates authorized in the Texas Open Records Act except that official transcripts will be $2.00. Official copies of academic records or transcripts will not be released for students who have a delinquent financial obligation or financial "hold" at UTEP.

8.6 Complaints
Complaints regarding alleged failures to comply with the provisions of the FERPA may be submitted in writing to the Family Policy Compliance Office, U.S. Department of Education, 400 Maryland Avenue SW, Washington, D.C. 20202-4605.
Introduction

What is BANNER?

Banner is a comprehensive, fully integrated, graphical user-interfaced Student Information System. It stores data in an Oracle relational database, and users interact with the system by means of screens (called FORMS).

How is data stored in BANNER?

Banner data is stored in an Oracle relational database, which means a collection of tables where data element names represent columns across the top, and data records are stored in rows. This table-driven database allows Banner to be flexible, time saving, and to assist in preventing errors.

A typical table might look like this:

<table>
<thead>
<tr>
<th>Student Id</th>
<th>Student Last Name</th>
<th>Student First Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456789</td>
<td>Bull</td>
<td>John</td>
</tr>
<tr>
<td>987654321</td>
<td>Jones</td>
<td>Judy</td>
</tr>
<tr>
<td>234567890</td>
<td>Smith</td>
<td>Rocky</td>
</tr>
</tbody>
</table>

The columns show data elements; the rows contain specific instances of data. The importance of these tables will become apparent to you as you become more familiar with the system.

What happens if I have a problem with BANNER?

The initial point of contact for assistance is your local computer systems administrator. If there is a problem that is not isolated to your PC, contact the HELP Desk (Ext.4357) for assistance. Sometimes the HELP Desk can solve the problem with you on the phone. At other times, the HELP Desk may have to contact either technical or functional experts to solve the problem, and will inform you if that is necessary. A procedure has been developed with the Technical Staff and the HELP Desk for troubleshooting.

What about security procedures?

1. **Log Off**: Make sure that you log off the system when you have finished with it or are going to leave your area for any amount of time. Please be aware that you are responsible for anything at your terminal if you leave it logged on to Banner.
2. **Do not** give out or share your login information with anyone. Again, you are responsible for anything done under your login.
3. **Recognize confidentiality**: The system will let you know who owns the information on the record you are viewing. If in doubt, call the HELP Desk.
4. **Don’t be** reckless with print screens. If you do not need screens that were printed, dispose of them properly. Try to print only screens that are absolutely necessary.

Please keep these things in mind as you use the system on a daily basis.
How to Log On

1. Double click on your internet browser (ex. IE)
2. Enter the URL address – http://banner.utep.edu
3. You will see this form:

   ![Logon Form](image)

4. Enter your Name
5. Enter your password
6. Enter prod
   a. “prod” stands for production database

You will now see the following, read and click “Accept”

![Security Statement](image)
Main Menu

This is an overall view of the “Main Menu”

The various parts of the “Main Menu” are:

- Menu Bar
- Tool Bar
- Title Bar
- Go to Field
- Hierarchical Menu
- Products Field
- Menu Link
- Site Map Link
- Help Center Link
- My Links Area
- My Institution
- Broadcast Messages
Main Menu

Menu Bar

The Menu Bar offers a variety of options for navigating with in Banner.

File Edit Options Block Item Record Query Tools Help

File Menu:
The File Menu contains standard SCT Banner and Oracle functions.

Direct Access: Access the Direct Access form GUAPARM, which allows you to type the 7 character form name to take you directly to the form.

Object Search: This allows you to access a form, job, or QuickFlow if you know part of the name, description, or type.

QuickFlow: This displays the QuickFlow form GUAQFLW which is used to access a QuickFlow.

Select: This will return you to the calling form and enters the selected value into the field that called the form.

Rollback: Depending on the type of form you are currently using Rollback; Clears all information except key information and returns you to the first enterable field in the key block for an Application and/or Inquiry form, Returns you to the first enterable field on the form for a Validation form, or Returns you to the first enterable field on the calling form for the Query form.

Save: Saves all changes entered since the last time you saved.

Refresh: Clears the message line; redraws the screen.

Print: Prints the current window; inputs the date and time in the title bar.

Exit: Will either: exit the form, exit Banner, or cancel a Query

Exit QuickFlow: Will exit the QuickFlow

Exit Banner: Will exit Banner

Return to Menu: This returns to the Main Menu

Preferences: This displays the Personal Preferences Maintenance form, GUAUPRF, which is used to customize SCT Banner for individual users.
Main Menu

**Edit Menu:**
The Edit Menu contains standard SCT Banner and Oracle functions.

- **Cut:** Selects text and places it on the clipboard
- **Copy:** Copies the selected text and places it on the clipboard
- **Paste:** Pastes text from the clipboard to the current cursor location

**Edit:** Displays the Editor window, which is used to enter and update text.

**Options Menu: (formally the Navigation Bar)**
The Options Menu varies from form to form. Some of the options on this menu take you to other blocks and windows within the current form; other options take you outside the current form.

The **Options Menu** from the Identification Form (SPAIDEN) is shown. Clicking the System Data Summary form (GUASYST) will take you outside the SPAIDEN form.

The **Options shortcut menu** can be accessed by right-clicking on a form from anywhere on the blank canvas (not from a field.) This list contains Rollback, Save, Exit, Print, and Add to Personal Menu, as well as any form-specific options.
Main Menu

**Query Menu:**
The Query Menu allows you to use options for searching the database.

- **Query**
  - Enter
  - Execute
  - Last Criteria
  - Cancel
  - Count Hits
  - Fetch Next Set

**Tools Menu:**
The Tools Menu is used for accessing “add-ons” to Banner.

Banner XtenderSolutions is an imaging and electronic document management system designed for higher education.

**Help Menu:**
The Help Menu allows you to access help options.

- **Online Help**: Displays online information for the current field or form.
- **Dynamic Help Query**: Displays the Dynamic Help Form (GUAHELP) in query mode, which is used to display traditional help for a field, block, or form.
- **Dynamic Help Edit**: Displays the Dynamic Help Form (GUAHELP) in edit mode, which is used to edit traditional help for a field, block, or form.
- **Help (Item Properties)**: Displays the Oracle item properties window for the current field.
- **Show Keys**: Displays the Keys list, which lists the functions and their equivalent keystrokes available for the current form, window, and field.
- **List**: Display the List of Values (LOV) for the current field if avail.
- **Display Error**: If an Oracle error occurs, display the code that is in error.

**Display ID Image**: If the cursor is in the ID field, displays the image associated with the ID (not available at this time)

**About Banner**: Displays the list of installed SCT Banner products, their release number, and their installation date.
Main Menu

Tool Bar
The Tool Bar is a set of icons that represent shortcuts for performing common functions.
**Main Menu**

**Title Bar**
The Title Bar refers to the bar at the top of the Banner form which provides descriptive information on the form. It includes the descriptive form name, 7-character form code, release number, database name and the current date.

**Go To Field**
The Go To Field allows you to access a form or launch a QuickFlow.

**Hierarchical Menu**
The Hierarchical Menu allows you to access forms through an expandable and collapsible hierarchical structure.

**Products Field**
The Products Field is a pull-down menu that expands the menu for the selected product.

**Menu Link**
Clicking the Menu Link highlights the top-level Banner menu.
Main Menu

Site Map Link
The Site Map Link allows you to access the site map, which show top-level and one level below menus in Banner. Example:

<table>
<thead>
<tr>
<th>My Banner</th>
<th>Financial Aid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Third Party Access Audit</td>
<td>Applicant Processing</td>
</tr>
<tr>
<td>Oracle Password Change</td>
<td>Need Analysis</td>
</tr>
<tr>
<td>Organize My Banner</td>
<td>Requirements Tracking</td>
</tr>
<tr>
<td></td>
<td>Budgeting</td>
</tr>
<tr>
<td>Student</td>
<td>Packaging and Disbursement</td>
</tr>
<tr>
<td>Course Catalog</td>
<td>Funds Management</td>
</tr>
<tr>
<td>Class Schedule</td>
<td>Electronic Data Exchange</td>
</tr>
<tr>
<td>General Person</td>
<td>History and Transcripts</td>
</tr>
<tr>
<td>Faculty Load</td>
<td>Financial Aid Common Functions</td>
</tr>
<tr>
<td>Location Management and House</td>
<td>Student System Shared Data</td>
</tr>
</tbody>
</table>

Help Center Link
The Help Center Link is currently not available.

My Links Area
The My Links Area contains these links

- **Change Banner Password**: this is the Oracle Password Change form GUAPSWD where you can change your password.
- **Check Banner Message**: takes you to the Banner Message Form GUAMESG, where you can view your message. A green checkmark appears when you have a pending or a new message arrives.
- **Personal Links**: this enables you to create up to six favorite URL or often-used Banner objects.
Main Menu

**My Institution**
The My Institution reflects a picture of UTEP and eventually its website.

---

**Broadcast Messages**
The Broadcast Message button on the toolbar becomes enabled whenever you receive a broadcast message.
Forms

What is a form?
A form is a document in which you enter and look up information stored in the student information database. Each form has a specific 7-character ID code.

7-Character ID Code

Position 1 Identifies the Banner product owning the form, report, process or table. Example:
A – Advancement
F – Finance
G – General
R – Financial Aid
S – Student
T – Accounts Receivable

Position 2 Identifies the application module owning the form, report, process or table. Example:
A – Admissions
C – Catalog
E – Support Services
F – Registration/Fee Assessment
G – General Student
H – Grades/Academic History
I – Faculty Load
L – Location Management
M – CAPP
O – Overall
P – Person
R – Recruiting
S – Schedule
T – Validation form/table
U – Utility

Position 3 Identifies the type of form, report, process or table. Example:
A – Application
B – Base Table
I – Inquiry
P – Process
R – Rule or Repeating Table
V – Validation
M – Maintenance

Positions 4 - 7 Identify a unique four-character form, report, process or table. Example:
***IDEN – Identification
***PERS – Person

For Example the Form SPAIDEN translates to: the Student product, Person module, Application for Identification.
Forms

Parts of a form
Banner forms can include these parts:
- Title Bar
- Fields
- Key Block
- Information Block
- Tabs
- Pull-down Lists
- Radio Buttons
- Checkboxes
- Calendar Icons

Title Bar
The Title Bar refers to the bar at the top of the Banner form which provides descriptive information on the form. It includes the descriptive form name, 7-character form code, release number, database name and the current date.

Fields
An area on a form where you can enter, query, change, and display specific information. Example:

ID:  

Key Block
Contains information that determines what is entered or displayed on the remainder of the form. The Key Block is positioned near the top of the form above a delineated line or tabs. Example:
Forms

Information Block
Display data about the information entered in the key block. Example:

<table>
<thead>
<tr>
<th>ID:</th>
<th></th>
<th>Name Type:</th>
<th></th>
</tr>
</thead>
</table>

Person

Last Name: 
First Name: 
Middle Name: 

Tabs
Used to arrange information in a meaningful way and allow you to navigate easily between groups or blocks of information. Only select forms have tabs. Example:

- Current Identification
- Alternate Identification
- Address

Pull-down Lists
Represented by a down arrow; indicates that a list of values or a search function in available for that field. (The previous version it was the blue font) Example:

State or Province: TX Texas

Radio Buttons
Used to select on of several options, only one button can be selected. Example:

Gender: 
- Male
- Female
- Not Available
Forms

Checkboxes
Used to enable or disable features or options. Example:

☐ Confidential
☐ Deceased

Calendar Icons
Accesses the Calendar Form (GUACALN) enabling you to select a date from a calendar for data-entry date fields. Example:

Birth Date:  

[Image: Calendar icon]
General Person Identification Form - SPAIDEN

To access the SPAIDEN form you can first click on the “STUDENT” menu, second click “General Person” menu, then click on the “General Person Identification Form.” Another way to access this form is to type SPAIDEN in “Go To” block on the main menu and then press enter key. If you click on the down arrow you will get the “Object Search” form, just click cancel twice and press the enter key. The following screen will then come up.

There are 3 ways to locate a person/non-person on any form with the ID in the key block. They are; By ID, By name, and Search. The 1st and most accurate is by ID. Notice that the top portion of your screen will allow you to type in the person’s ID number and then the name will appear.
General Person Forms

The second way is to blank out the ID, then press the tab key once so you can type the person’s “Last Name, First Name” in the name field. If only one person is found their name should appear in the name block. If more than one person is found you will receive the following pop-up.

![Pop-up for multiple search results]

This is saying there are 5 people with this name. Click the down arrow to view the name.

The third way to look up a person is by pressing on the button.

![Identification screen]

When you run the search query, an option list with two choices will pop up. When you click on the text and select **SOAIDEN**, you will search for a person on the system. A non-person search brings up information on other third parties such as companies or departments.
General Person Forms

You should now be on the following query screen.

<table>
<thead>
<tr>
<th>ID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Middle Name</th>
<th>Birth Date</th>
<th>Change Indicator</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>test</td>
<td>%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This screen will allow you to search for a person via last name plus first name. **Banner is case sensitive unless you click the “No” button under “Case Sensitive Query.”** Otherwise, it will recognize names with capital letters in the first and last name. Make sure that you select the “Execute Query” button at the top of the screen. Remember that you do not have to be specific if you are unsure of the name. For example: Let’s say you are searching for Ima Test but are unsure if her is name is Ima or Imma. You can type “Test” in Last Name and then type I% in the First Name and then click on the “Execute Query” button. Remember that the “%” sign is a wildcard sign that Banner recognizes to look for all possible combinations of what it is placed next to. In this case Banner will look for all records ending in Test and starting with the letter “I”. Displayed on the next screen will be a list of names with their information. If you make a mistake and you need run another query, just click on the “Enter Query” button and it will clear the screen and allow you to search for another person. Once you find the person you are looking for, you can then select the person by double clicking on the ID with your mouse, or using your arrow keys to highlight the person and then click on the “SELECT” button.

This will now bring you back to the main **SPAIDEN** form. The top information should now have person’s name and ID filled in. The next step is to use the Next Block command. The Next Block command will update the screen or form with the user’s information.

You can access the Next Block command by the drop down menu. Or you can access the same command by using the “Next Block” icon or by clicking in any white box. Remember: You can always go back from Next Block by using the Previous Block command.
As you can see on the following screen, the student’s information has been updated.

If you receive a pop up box like the following, it is telling you that this person has requested that their information be confidential. The information is available for the legitimate use of the University and is not to be given out.

You can now view some student information by clicking on the various tabs.
General Person Forms

- **Address**--This will give you all the current addresses for the student you selected.

<table>
<thead>
<tr>
<th>Current Identification</th>
<th>Alternate Identification</th>
<th>Address</th>
<th>Telephone</th>
<th>Biographical</th>
<th>E-mail</th>
<th>Emergency Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date:</td>
<td>11-SEP-2008</td>
<td>To Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address Type:</td>
<td>MA Mailing</td>
<td>Sequence Number:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Street Line 1:</td>
<td>123 Hill Moon Bay</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Street Line 2:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Street Line 3:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City:</td>
<td>Martha's Vineyard</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State or Province:</td>
<td>MA Massachusetts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZIP or Postal Code:</td>
<td>86210</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nation:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telephone Type:</td>
<td>MA Mailing</td>
<td>Telephone:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type:</td>
<td>This is the type of address associated with the person. The most common types are: MA: Mailing, PR: Permanent, RS: Residency</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Seq #:</td>
<td>This is the most current record for each type. The greatest number is the most current.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From:</td>
<td>The start date of the address.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To:</td>
<td>The end date of the address.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactive:</td>
<td>This is checked if the address information is inactive.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source:</td>
<td>The address source code.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User:</td>
<td>This field identifies the last person who updated this form.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activity Date:</td>
<td>The field identifies the last date the form was updated.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type:</td>
<td>This ties the phone number to the type of address associated with the person. The most common types are: MA: Mailing, PR: Permanent, RS: Residency</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Rule of Thumb:**

Remember that Rollback will always take you to the top of the form to enter another student ID. Return will bring you back to the first form. Exit will take you out of the form completely. Your best bet to get back to the original form is to try these commands in the following order: Return, Rollback, and as a last resort Exit.
Hold Form - SOAHOLD

If you wish to know the specific holds on a student, go back to the main menu by clicking on Exit. Type **SOAHOLD** in the “Go To” block. Now just select Next Block to get the following updated screen.

As the above sample shows, six holds will appear at a time on a page. If there are more than six holds, you can use the scroll bar to view the remainder. A hold is considered active when the “From” date is today or before and the “To” date is today or after. (The time is 24 hours) If the “Release Indicator” box is checked, that means the only the names/department appearing in the next box can release the hold. When you are done viewing you can just exit.
General Student Forms

General Student Form - SGASTDN

If you wish to know the specific holds on a student, go back to the main menu by clicking on Exit. Type **SGASTDN** in the “Go To” block.

The form will now list the student you have selected. This form will give you the student’s academic standing as well as other general information. The importance of the Summary button is that you can quickly view all the term information in a short concise form. This form will allow you to view the academic standing and major the student is pursuing in any given academic term. By selecting from this form it will update and bring you back to the SGASTDN form. This will prove handy if you need to query for a specific term. If you have a term already in mind, you can then type in the term in the term section. However, if you want the student’s current record leave the term BLANK.

**Term Hints:**

You can change from one term to another depending on the information you wish to look at. Remember the term is always the second of the two years of the academic year as traditionally set forth (thus 1998-99 = 1999) followed by 10 for fall, 20 for spring, 30 for summer. If this is somewhat confusing you can click on the Term button and a table with the term codes and their descriptions will pop up. Just select the term you want and select OK.

To update the form simply click on Next Block. The screen should now update and look as follows.
As you can see, the student’s current information is quickly brought up for you to look at. This student’s status is active, it shows he is a senior, and that he could be a continuing student. You can access different areas that relate to this student from the Options drop down menu. This will become more and more important as you become familiar with the various screens and forms that you access daily.
Registration Forms

Registration Query Form - SFAREGQ

To view a student’s current registration, use the SFAREGQ form. Once you are into SFAREGQ, you must specify the term by typing it in the appropriate section and an ID. If you are unsure, just click on Term for a list of all terms and then choose from the table list. Once you choose the term and ID, click on next block, and your screen should look like this.

<table>
<thead>
<tr>
<th>Term</th>
<th>CRN</th>
<th>Subject</th>
<th>Course</th>
<th>Section</th>
<th>Registration Status</th>
<th>CRU</th>
<th>Cross List</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
<th>Begin Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>200710</td>
<td>15526</td>
<td>PHYS</td>
<td>2421</td>
<td>bron</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part of Term:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Start Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200710</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Instructional Method:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grade Mode:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Hours:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>End Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Term</th>
<th>CRN</th>
<th>Subject</th>
<th>Course</th>
<th>Section</th>
<th>Registration Status</th>
<th>CRU</th>
<th>Cross List</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
<th>Begin Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>200710</td>
<td>15924</td>
<td>PHYS</td>
<td>2421</td>
<td>007</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part of Term:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Start Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200710</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Instructional Method:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grade Mode:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Hours:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>End Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Term</th>
<th>CRN</th>
<th>Subject</th>
<th>Course</th>
<th>Section</th>
<th>Registration Status</th>
<th>CRU</th>
<th>Cross List</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
<th>Begin Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>200710</td>
<td>15980</td>
<td>PHYS</td>
<td>2421</td>
<td>007</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part of Term:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Start Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200710</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Instructional Method:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grade Mode:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Hours:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>End Date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can see that the student is carrying 14 hours for this semester. The first 3 courses are listed here and you must use the scroll bar to view the rest of his courses.
Using the **SFASRPO** form you can view overrides for a specific term. By bringing the form up and giving a term and student ID and selecting Next Block, you can quickly access the student’s registration information for the term specified. The following screen gives an example of this.
If you need to check the status on a student’s degree, you can access this information with the SHADEGR form. When you open up the form, you will type in the student’s ID or you will search for the student by surname. Once the student’s records have been found, you must insert the Degree Sequence number. This number informs Banner which degree you are looking for if the student intends to pursue subsequent degrees. You can query by clicking on the button. This will take you to a different screen. Once you find the number you are looking for, just click on Select and it will take you back to your original screen. Clicking Next Block will bring the following screen up.

This screen shows the status of the degree and any graduation information that is relevant. The Calculate Degree GPA button will automatically calculate the GPA and display it for you. Student Curriculum will display all majors that the student is currently seeking.
Academic History by Term - SHATERM

To view all courses and grades by term, use the SHATERM form. Once you bring up this form, you will need to specify the level of the student (undergraduate or graduate). If you select a term then you will only be able to view from that term onward. Leaving the term selection blank will allow you to view all the student history from the most current semester. Once this is done, click Next Block.

<table>
<thead>
<tr>
<th>Current Standing</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Term Attended:</strong></td>
</tr>
<tr>
<td><strong>Last Term Attended:</strong></td>
</tr>
<tr>
<td><strong>Academic Standing:</strong></td>
</tr>
<tr>
<td><strong>Academic Standing Override:</strong></td>
</tr>
<tr>
<td><strong>Progress Evaluation:</strong></td>
</tr>
<tr>
<td><strong>Progress Evaluation Override:</strong></td>
</tr>
<tr>
<td><strong>Combined Academic Standing:</strong></td>
</tr>
<tr>
<td><strong>Combined Academic Standing Override:</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Attempted Hours</th>
<th>Passed Hours</th>
<th>Earned Hours</th>
<th>GPA Hours</th>
<th>Quality Points</th>
<th>GPA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Institution:</strong></td>
<td>69.000</td>
<td>46.000</td>
<td>69.000</td>
<td>64.600</td>
<td>258.90</td>
<td>3.90</td>
</tr>
<tr>
<td><strong>Transfer:</strong></td>
<td>-</td>
<td>.000</td>
<td>88.000</td>
<td>.000</td>
<td>.00</td>
<td>.00</td>
</tr>
<tr>
<td><strong>Overall:</strong></td>
<td>69.000</td>
<td>56.000</td>
<td>156.000</td>
<td>64.600</td>
<td>258.90</td>
<td>3.90</td>
</tr>
</tbody>
</table>

**First Term Attended:** This is the first term the student attended UTEP.

**Last Term Attended:** This is the last term posted in history that the student attended.

**Acad Standing:** The student’s current academic standing.

**Override:** Displays the user entered academic override standing.

**Overall Institution GPA:** UTEP GPA information

Click next block again and you will get the following block.
As the previous screen shows, the student academic history by term is now on screen. Using the scroll bars on this form, you can scroll down through the student’s academic history by term.
Academic History Forms

Academic History by Subject - SHASUBJ

Another form that looks similar to SHATERM is the SHASUBJ form. This form will allow you to look for grades by subject. You can select the subject you wish to start with, or you can leave it blank and all subjects will be listed. Clicking on Next Block will update the screen and will look like the first screen in SHATERM (see above). Clicking Next Block again will take you to this screen.

This information shows the attempted hours, passed hours, earned hours and GPA for each course. Notice the Subject heading at the top right. As you scroll down on the scrollbar, you will notice that the subject and course will change, allowing you to view the different classes this student has taken. If the student has attended several terms at the University, this list may become quite long; as you start to use this form, it will be to your advantage to choose a subject to start out with. Doing so will bring you to the right starting place to view course information.
Academic History Forms

Academic History by Course - SHACRSE

To find grades for a particular term you can use SHACRSE. Bringing this form up and choosing the term will give you the grades for that term. If you leave the term blank, the screen will show all the courses the student has taken from the most current to the least current. The following is how the form will look. This is a good screen for printing all the courses a student has taken.
Test Scores and Grades – SOATEST

From time to time, you may need to check on a student’s standardized test scores. Banner provides an excellent form for viewing this information. The name of the form is SOATEST. When you bring up the form and click on Next Block, it will look something like this:

If there are more test scores, you will be able to use the scroll-down menu to view them. Other scores that may show up here for you to view are test scores for CLEP, GRE, SAT, other national test scores, and any local (UTEP) placement test scores.

If for any reason a student’s test score is not listed here, please notify the following:
- For all undergraduate national test scores and local placement test scores, please notify Undergraduate Admissions.
- For all graduate and doctoral test scores, please notify the Graduate School.
Add/Change Personal Links

To add/change your personal links click on “File” then “Preferences”

Click “My Links” Tab

Enter the Title of your 1st link

Enter the URL of your 1st link. Then click “Save” or  
Your link will be add the next time you log in.
Changing your Password in Banner

Your Banner password and your login id are the keys to your Banner account. Anyone who knows these two items (or can guess them) has access to all the data that you have access to. He or she can view, alter, or delete any data that you have access to. It is your responsibility to protect your account information by keeping your login id and password from becoming known to anyone else. It is also important for you to routinely change your password frequently. This is just as important as locking the file cabinets, the safe, or the office door when you leave at the end of the day.

Changing Your Login ID: You cannot change your login ID, but IT personnel will be happy to change it for you. If you feel that there is a reason to change your ID, call The Help Desk at 4357.

How to Change Your Banner Password: You can change your Banner password anytime you desire. It is easy to do if you follow the instructions below.

Start Banner and log in.
Type GUAPSWD in the “Go To” box in the upper-right portion of the Banner screen and press the Enter key or click on Change Banner Password.

This will display the Oracle Password Change Form.

![Oracle Password Change Form]

- Type your old (current) password below your Oracle User ID.
- Type the new password twice.
- Click the Save button.

Your password will be changed by Banner immediately.